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The information in this user manual may be changed without prior announcement. The manufacturer 
or retailer is neither liable nor responsible for any errors or omissions in this manual, or for any 
damages resulting from the use of this manual. The information in this manual is protected by 
copyright law. This manual may neither completely nor partly be photocopied or reproduced in any 
form without written consent.  

The software described in this manual is supplied under a license agreement. This software may be 
used exclusively in accordance with the contract terms.  

With the purchase of this software, you have agreed to the content of the license agreement, which 
only allows end users to use this software. Any reproduction or further distribution of this software is 
legally forbidden and can result in severe civil and criminal penalties. Each offence will be pursued 
excessively.  

EPIC Erfurt hereby rejects any warranty and liability in regard to the software including any implied 
guarantee and other warranties regarding fitness, suitability for a certain purpose and liberty of third 
party rights, as far as this is legally possible.  

EPIC Erfurt is in no case responsible for indirect damage, consequential damage or damage due to 
downtime, loss of data or escaped profit and any such damage that directly resulted from or in 
connection with the use of this software’s documents.  
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1. Introduction 

Controlling construction, accounting, as well as generating and evaluating measurement sheets are 
often very time-consuming tasks. The EPIC Measurement Module 2.0 significantly facilitates the 
handling of measurements for you. It reduces expenditure, prevents writing errors and reduces the 
subsequent accounting work. It offers the current GAEB and REB interfaces and is easy and flexible in 
its application. It can be used for both small and large building projects as well as for all trades. The 
EPIC Measurement Module 2.0 is a low-priced software with free Hotline and continuing maintenance. 

1.1. Important information for users of the Measurement Module Version 1.2 

The installation of version 2.0 has no impact on the existing Measurement Module Version 1.2. Both 
versions can be used in parallel.  In order to use measurement projects created with version 1.2 in the 
new version 2.0, the entire project must be imported (see 4.2). Importing projects from version 2.0 into 
an older version is not possible. 

1.2. System requirements 

The EPIC Measurement Module is an Excel Add-in and requires Microsoft Excel 2003 or higher. 

Required software:  
• Windows XP (SP3) or higher (32bit or 64bit) 
• Microsoft Excel 2003 or higher (only 32bit) 
• Note: Office 2013 RT editions are NOT supported  

1.3. Overview of the functionality of the EPIC Measurement Module Version 2.0 

Selecting from different measurement templates: 
To create a new project, you can choose from a selection of different templates.  Thus, measurement 
sheets are possible in upright format or with positions in rows instead of in columns. 

Supporting BOQs and ordinal numbers with up to 14 places and 5 hierarchy levels: 
Version 2.0 supports all ordinal number formats of the GAEB 1990 as well as the GAEB 2000 and 
GAEB 2000 XML. Therefore, ordinal numbers with up to 14 places and up to 5 hierarchy levels can be 
used. 

Importing BOQs and price lists in GAEB 1990, GAEB 2000, GAEB 2000 XML formats: 
Bill of quantities and price lists from the GAEB 1990 formats *.D81, *.D83, *.D84 and *.D86, from 
the GAEB 2000 formats *.P81, *.P83, *.P84 and *.P86, as well as the GAEB 2000 XML formats 
*.X81, *.X83, *.X84 and *.X86 can be imported. 

Importing room lists: 
Excel formatted room lists can be imported. 

Collecting bill of quantities (BOQs) and room lists (RLs) manually: 
You can also enter bills of quantities and room lists manually, instead of importing them. 

Importing measurements from version 1.2: 
Projects, which were created in version 1.2, can be imported into version 2.0. 
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Importing measurements from DA11 files: 
Simple DA11 files with quantity specifications in the formula number 91 (without calculation 
approaches) can be imported into measurements. 

Transferring BOQ positions and rooms directly from the BOQ and/or the room list: 
In order to save writing effort, several positions from the BOQ or several rooms from the room list can 
easily be transferred to the measurement sheets. 

Checking for incorrect entries: 
When creating measurements the program checks whether the positions, rooms or quantities entered 
are correct and refers you to incorrect entries. 

Exporting measurements in DA11, DA11E, DA12 and X31: 
Measurements can be exported in DA11 and DA11E format. The export takes place either according to 
the REB 23.003 edition 1979 or the new REB 23.003 from the year 2009, which also supports ordinal 
number formats different than 11.22.PPPP.I. Furthermore, measurements can also be exported into the 
DA12 format of the GAEB 23.004 or X31 format of the GAEB DA XML 3.2, whereby ordinal 
numbers with up to 14 places are supported. 

Printing measurements with and without calculation approaches:  
When printing the measurement, you can decide whether only the results or the calculation approaches 
like e.g. =3.5+2.3 should also appear in the print out. 

Generating new blank measurements by push of a button: 
You can create a further blank measurement to the existing project with one single mouse click. 
Measurement number, building project and contractor are entered automatically. The sheets are 
numbered consecutively. 

Evaluating one or several measurements for the control of quantities, cost and accounting: 
The measurement module offers different evaluative options for the control of quantities, cost and 
accounting. You can select which measurements are to be included into the evaluation and you can 
filter by rooms and positions.  

Generating and importing building site measurements: 
You can prepare blank measurement sheets with pre-entered positions and rooms, which you can print 
out and use on the building site. Alternatively, these sheets can be filled in Excel and imported. 

Checking automatically for new program updates: 
The measurement module automatically checks for new updates at regular intervals. Thus your 
program is always up to date and you will not miss any new functions. 

File structure: 
For each new measurement, the program generates a separate Excel file.  Likewise, the BOQ and the 
room list are located in separate Excel files. All Excel files of an EPIC Measurement Module project 
are stored in a common folder. This folder is titled with the project name and contains the project file 
with the suffix *.amxml.  

Important: The project file *.amxml may under no circumstances be deleted or changed and projects 
should always be copied as complete folders.  Please do not rename the Excel files in the project 
folders. If you need a different file name, please perform the renaming in the form "Project Settings" 
(see 9.1). 
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2. Installation and activation 

2.1. Installing the EPIC Measurement Module Version 2.0 

For Excel 2013 or higher: In case you have not chosen the standard installation at the initial 
installation of Microsoft Office, please make sure that the .NET Programmability Support for 
Microsoft Excel was installed. You can check this in the list of installed programs and updates on your 
computer: Right-click on "Microsoft Office 20XX" → "Change" → "Add or remove features" and then 
select "Microsoft Excel" and set the ".NET Programmability Support" to "Run from My Computer". 

Prior to the installation of the EPIC Measurement Module, please check the safety settings of Excel as 
follows: 

• For Excel 2003, please go to "Tools" → "Options" → "Security" → "Macro Security" → "Trusted 
Publishers" and select the option "Trust all installed add-ins and templates". Otherwise, Excel will 
ask you at each start whether you would like to activate the macros in mscoree.dll. These macros 
must be active, so that the measurement module is loaded as add-in. 

• For Excel 2007, please go to "Office" on the upper left → "Excel Options" → "Trust Center" → 
"Trust Center Settings" → "Add-ins" and deactivate the functions "Require Application Add-ins to 
be signed by Trusted Publisher" and "Disable all Application Add-ins". 

• For Excel 2010 or higher, please go to "File" → "Options"→ "Trust Center" → "Trust Center 
Settings" → "Add-ins" and deactivate the functions "Require Application Add-ins to be signed by 
Trusted Publisher" and "Disable all Application Add-ins". 
 

Prior to the installation, please close all applications in use, in particular Excel. Make sure you have 
signed in as administrator. Unpack the installation package EPIC_Aufmassmodul_2_0_Setup.zip in a 
folder of your choice. Then start the installation by double clicking on the 
EPIC_Aufmassmodul_2.0_Setup.exe file. Follow the installation instructions. 

In case it is not yet present on the computer, Microsoft .NET Framework 4.0 is provided and installed 
for the installation. To install the Framework, Windows Installer 3.1 or higher and the Windows 
Imaging Component are required. If these components are missing, a reference appears during the 
installation process and the installation is terminated. Please install the missing components (available 
for free on www.microsoft.de) and restart the installation of the EPIC Measurement Module.  

Once you have completed the installation of the EPIC Measurement Module, you can start Excel.  The 
entry "EPIC" will now appear at the end of the menu panel. 

2.2. What to do if the menu entry "EPIC" does not appear after completing the installation? 

If, after a restarting your computer and despite correct safety settings in Excel, the menu item "EPIC" is 
still missing, the add-in may possibly have been deactivated and needs to be reactivated manually.    
This may also happen after the installation of an update or after a crash of Excel. In order to activate 
the add-in, please proceed as follows: 

• For Excel 2003, please select "Help"(?) → "About" → "Disabled items". If the "EPIC Measurement 
Module 2.0" there appears, select it and click on "Activate". After restarting Excel, the menu 
"EPIC" should then appear. 

http://www.microsoft.de/


 
 
 

 
Engineering Office 
Elektroplanung GmbH 

 
 
 

 
 7 

 

 

EPIC

Trade Register Jena, HRB 103884 
Managing Director:  
Dipl.-Ing. W. Sturm 

• For Excel 2007 or higher, please go to "File" → "Options" → "Add-ins" and check whether the 
"EPIC Measurement Module 2.0" is to be found among "Disabled application add-ins" or "Inactive 
application add-ins",  
o In case of "Disabled application add-ins": In the same window below, go to "Manage", select the 

entry "Disabled items" and click on "Go…". Another window will open in which you can 
activate the EPIC Measurement Module add-in. 

o In case of "Inactive application add-ins": In the same window below, go to "Manage", select the 
entry "COM add-ins" and click on "Go…". Another window will open in which you can place a 
check mark in front of "EPIC Measurement Module add-in" for activating it. 

Afterwards "EPIC" should appear in the menu now. It may be necessary to restart Excel. 

2.3. Activating the EPIC Measurement Module 

After the installation, the EPIC Measurement Module 2.0 will be in test mode for 7 days. In order to be 
able to use the program beyond the testing period, you need either a job-bound license key or a dongle, 
which allows you to use the license on different computers. You can order both under http://www.epic-
software.de. 

Once you have received a dongle, connect the dongle to a USB port of your computer before starting 
Excel. Now you can start Excel and put the measurement program to use. The dongle must be 
connected to the computer for the entire operating time of the measurement program. 

If you received a license key in place of a dongle, select "Activate" (1) in the EPIC menu to enter the 
license key. 

 
An input mask will open into which you can enter the data from the license form. The license key is 
only valid in combination with your user name and/or the work place as well as the company name. 
You can enter the license key with or without separators. After the successful activation, the "Activate" 
button will disappear from the EPIC menu and you can use the program for an unlimited period of 
time. 

 

1 

http://www.epic-software.de/
http://www.epic-software.de/
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3. The EPIC-Menu 
The charts provided in the manual were generated in Excel 2010. In Excel 2007 and higher Excel 
versions, the appearance of the menu is very similar, while Excel 2003 shows larger deviations due to 
its older menu structure. If you use Excel 2003, you will find in the appendix of this chapter an 
additional overview, which illustrates the menu graphics' appearances in Excel 2003. 

After the installation of the EPIC Measurement Module 2.0 the entry "EPIC" appears at the end of the 
Excel menu bar, as represented in the following graphic: 

 
You will see the group "EPIC Measurement Module 2.0" (1) with the instructions "New Project", 
"Import Project", "Activate", "Settings" and "Info" (2). The group "EPIC Measurement Module 2.0" is 
always visible. 

Depending on whether a measurement file, a bill of quantities or a room list is in use and displayed, the 
EPIC menu will open further groups, like e.g. "Measurement" (3) and "Project" (4), if a measurement 
file is opened and currently displayed. 

 
 In Excel 2003, for each group its own menu entry is created. The menu entry "EPIC" in Excel 2003 (5) 
corresponds to the group "EPIC Measurement Module 2.0" in Excel 2007 or higher (1). In Excel 2003, 
the groups "Project", "Measurement", etc. appear as menu entries with the same titles (6). These menu 
entries contain the same instructions as the corresponding groups of the Excel 2007 (or higher) menu 
panel. The only exception being the dropdown fields for positions and rooms which, in Excel 2003 
appear in a separate toolbar (7). For further information on the appearance of the EPIC menu and the 
toolbar in Excel 2003, please consult the appendix (chapter 11). 

 

 

1 

2 

3 4 

5 6 
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4. Creating projects 

 

4.1. Creating a new project in Version 2.0 

Selecting "New Project" (1) in the EPIC menu opens a window into which you can enter the necessary 
data for the project: 
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Enter the building project and the contractor into the project details (2). The project name will be 
transferred into the first line of the building project (3). However, you can change the project name, if 
necessary. The project name indicates the title of the project file, which will be generated later and 
which contains the measurement files as well as the BOQ and room list file. If you wish to start the 
project with a sheet number different than 1, you can specify this here (4). 

You can also select and import a BOQ or otherwise specify your own ordinal number format (OZ 
format) (5). If no BOQ is imported, an empty BOQ is generated which you can later fill out manually. 
The OZ format can also be changed later on. At the end of this chapter, you will find details on 
importing a BOQ and on specifying the OZ format. 
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You can import a room list from an Excel file. To do so, click on "Select RL" (6) and select the Excel 
file that contains the room list. This file must contain the room numbers in the first column and, 
optionally, the room name in the second column. You can choose whether the first row of the room list 
file should contain column headings only or also room names by checking the "include column 
headings" box. If you do not import a room list, an empty room list is generated which you can later fill 
out manually.  You can still import room lists into the project later on.  

You can select the desired measurement template for the project by going to "Layout" (7). Templates 
are available in portrait and landscape format with positions in rows or columns. There is also a 
template that permits the entry of electric circuits in addition to the rooms. 

By clicking on "Change folder" (8) you can select the folder you wish the project to save in. A new 
folder with the project name is then generated in the selected folder.  If you wish to save all future 
projects to this place by default, please activate the option "set as standard folder". 

Selecting "Create project" (9) will generate a new folder with the title of the project in the selected 
storage folder. The BOQ and RL file as well as the measurement No.1 will be generated in this folder.  
Measurement No. 1 will be displayed. 

 
Manually specifying BOQ import or OZ format (5) 
 
Importing BOQ: 
If, upon creating a project, you wish to import a BOQ from a GAEB file, select the option "Import 
from BOQ" in the menu item "OF-Format" (5). After clicking on "Select BOQ" (12) select the GAEB 
format of the BOQ to be imported. The OZ format, as it is imported from the BOQ file, appears in the 
line "OZ-Format" (10). The file name of the BOQ file to be imported appears in the line "BOQ" (11). 
After creating a project, you still can import a BOQ.  

 
 
Specifying OZ format manually: 
If, upon creating a project, you do not wish to import a BOQ, you must specify the OZ format 
manually. To do so, go to "OZ format" (5) and select "specify manually". As a standard, the menu item 
"OZ format" (10) is equipped with the GAEB DA1990 format: 1122PPPPI. You can specify your own 
OZ format by selecting "Change format" (13). For this purpose, the window "OZ Format Settings" will 
open. 
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You can select the desired GAEB standard (14) in "GAEB DA Standard". GAEB DA 1990 permits 
ordinal numbers with up to 9 places and 4 hierarchy levels. GAEB DA 2000, as well as GAEB DA 
2000 XML, supports ordinal numbers with up to 14 places and 5 hierarchy levels. In GAEB DA 2000 
XML, all places can be documented alphanumerically. In GAEB DA 2000 and GAEB DA 1990, only 
the index may be alphanumeric. You can specify the number of places for the individual hierarchy 
levels; in GAEB DA 2000 XML, you can determine their data type (numeric or alphanumeric). With 
alphanumeric fields, you can specify the alignment of the field contents, which impacts the sorting of 
the item numbers. On the bottom left of the window, the current OZ format is displayed for control 
purposes (15). Verify the settings of the OZ format with "OK" (16). You can still change the OZ 
format after creating the project and/or have it changed when importing a BOQ.  
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4.2. Importing a project from Version 1.2 into Version 2.0 

 
In order to be able to use a project created with version 1.2 in version 2.0, the project must be imported 
via the "Import Project" button (17) in the EPIC menu. Upon selecting, a window opens from which 
you can select the project-related measurement files. To do so, double click into the first line of the 
table (18) and select the Measurement No.1 file of a version 1.2 project. The column "Match" (19) 
checks whether the number of the entered measurement file complies with the row number (20) of the 
table. 

In case the file names of the further measurements of the project only differ in their measurement 
numbers, you can ask the program to enter the remaining measurement files of the project by using the 
"enter automatically" (21) button. Otherwise, you must individually select all remaining measurements 
of the project by double clicking into the table row. All measurement files entered can be deleted from 
the table by using the "Empty table" command (22); by selecting "Delete entry" (23) only the selected 
file will be removed from the table. You can modify the recorded measurement files by double clicking 
on the file name in the table.  

 

17 
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Building project (24) and contractor (25) are read in from the first measurement file. These can also be 
changed, just like the project name (26). You must select from which indicated measurement files you 
wish to import the BOQ and the room list (27), since version 2.0 provides only one BOQ and only one 
room list for all measurements. Therefore, you want to select the measurement file containing the most 
current BOQ and the most current room list. The format of the ordinal numbers can also be changed 
(28), as already described under 4.1. However, the format selected here must be compatible with the 
positions entered in the measurement files. Next, you must select the folder (29) in which you wish to 
create a new project with for the imported files. This new folder is then assigned the project name (26). 
Select "Import" (30) and the measurements will be imported into version 2.0. The last imported 
measurement will be displayed.  

Notes for the import of a project from version 1.2: When importing a project into version 2.0, the 
original files generated in version 1.2 remain unchanged! The imported project is stored in its own 
new folder. A project imported into version 2.0 cannot be edited again with version 1.2 or imported 
back into version 1.2.  
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5. Processing measurements 
Processing a measurement is described in the following on the basis of the classic layout. In case you 
have selected a different layout, processing takes place analogously. 

 
 

5.1. Entering a date 

Measurement number (1), building project and contractor (2) are pre-entered into the measurement. 
You only have to add the date (3) in the top right. Only enter the date into the first sheet of each 
measurement and it will be transferred to all further sheets. At the bottom, you see the number of the 
current measurement sheet displayed as the title of the worksheet (4). If the page number is highlighted 
in green, this means that no errors were found in the measurement sheet. 

7
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5.2. Entering positions 

You can enter the ordinal numbers of the positions used in the row "Position" (6) in the position field 
(5). Please enter only the ordinal numbers specified in the BOQ file. Outline text and measurement unit 
are added automatically following the position entry. Otherwise an error message appears and the entry 
is marked red. The colour of the worksheet (4) also turns red, if an error was found in the sheet.  

It is recommended to adopt the positions from the dropdown fields (7) in order to avoid possible 
writing errors. To do so, select any cell (position, outline text, unit or a cell within the quantity range 
(8)). Then click on the position dropdown field (7) and select the desired position. The associated 
values are then transferred automatically into the position fields of the selected cell. 

Notes for the use of supplements: All supplements must be entered into the BOQ file of the project 
(see 6.2). The identification of the supplements is upon you as a user. In case the ordinal number 
format does not permit an index, you may use the index "N", or enter supplements under a new 
hierarchy level. 

5.3. Entering rooms 

Entering the rooms can take place manually in the column "Room name" (9) or can be selected from 
the dropdown field "Rooms" (7). Only rooms may be entered that also appear in the room list; 
otherwise, an error message appears, the entry is marked red and the sheet colour will change to red 
(4). 

5.4. Entering quantities 

You can manually enter the quantities for the positions and rooms into the "Quantity" field (8), either 
as single quantities (e.g. 1.4) or as an Excel formula starting with the equals sign, e.g. =3.5+4*1.5. 
When using Excel formulae only the result appears in the cell. Printing the measurement sheet, 
however, the calculation approach can be displayed optionally (see section 5.9 and 9.2). The quantity 
specifications may not contain any measurement units. 
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5.5. Creating a new measurement sheet  

To create a new measurement sheet select the "New sheet" button (10). Clicking on this button will 
generate a new, blank measurement sheet without quantities, positions and rooms at the end of the 
measurement. 

5.6. Copying a measurement sheet  

Selecting the button "Copy sheet" (11) will copy the current measurement sheet and can insert it at any 
place. You can select as which sheet the copied measurement sheet is to be inserted. You can also 
determine whether the recorded quantities are to be copied as well. Otherwise only the recorded 
positions and rooms are copied. 

5.7. Deleting a measurement sheet 

To delete the current measurement sheet use the button "Delete sheet" (12). 

5.8. Calculating a subtotal 

Selecting "Subtotal" (13) will calculate the intermediate total at the end of the page.  

5.9. Generating a print preview of a measurement  

Selecting "Print" (14) will generate a print preview of a complete measurement print out. Refer to EPIC 
"Options" to specify whether formula approaches should be displayed in print outs of the measurement 
sheets (see section 9.2). 

5.10. Importing data 

Selecting “Data Import” (15) will let you choose between importing DA11 files and importing EPIC 
measurement sheets. 

Simple DA11 files containing only single quantities in the formula number 91 can be imported into a 
measurement in the EPIC Measurement Module. Upon clicking on "Import DA11" a file selection 
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15 
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window will open from which you can select the DA11 files to be imported. The quantities contained 
in the file are imported into the measurement. 

In addition, EPIC measurement sheets from other EPIC measurement files or from building site 
measurements can be imported. For this, the layout of the sheets to be imported must be compatible 
with the layout of the current project, i.e. the number of rows and columns must be the same. After 
clicking on the button “Import EPIC measurement sheets”, choose the measurement file from which 
the sheets should be imported. A preview of the file is shown along with a window that allows you to 
choose the sheets to be imported. Last, please select the layout of the sheets to be imported. If the 
layout is compatible to the layout of the current project, the selected sheets are appended to the current 
measurement file. 

5.11. Exporting measurements  

By clicking on the button "Export" (16) you can choose from different options for the export of the 
current measurement in DA11, DA11e and DA12. If you select to export "Plus rooms", each registered 
quantity will be exported individually along with the assigned room. If you select to export in "short 
form", only the totals of the positions of each sheet without room specifications are exported. 

When exporting "Plus rooms" in DA11 or X31, only the first 9 characters of the room number are 
exported. If you use longer room numbers, you may want to select the DA11e format, which can take 
up to 33 characters of the room number. 

 

 
Exporting in DA11, DA11e or X31, you are being offered different export settings. If the project uses 
the REB ordinal numbers format 11.22.PPPP.I, you can select whether the file is to be generated 
according to the old 1979 REB 23.003 edition or the new 2009 edition (17). Some older programs with 
DA11 interface can import only DA11 and/or DA11e files according to the 1979 REB 23.003 edition. 
With OZ formats different than 11.22.PPPP.I, these options are greyed out and the file is generated 
according to the 2009 edition since deviating ordinal number formats are supported only here. When 
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exporting in DA11 or DA11e, you can also select whether idle numeric places of the ordinal number 
are to be filled with zeros or with spaces (18). Here, too, the option you select depends on the program 
into which the DA11 and/or DA11e file is to be imported later on. Furthermore, you can select whether 
equations shall be exported (19). Please note, that only short equations with up to 38 places can be 
exported. In case the equation is longer, only the result is exported. Upon selecting the desired options 
click on "OK" and a "Save As" window will appear. You can now choose a name and place to which 
you wish to save the DA11 and/or DA11e file.  

In case the measurement uses an OZ format with more than 9 places, it can be exported only in DA12 
or X31, since DA11 and DA11e support only ordinal numbers with a maximum of 9 places. Exporting 
in DA12, only the sheet totals without room specifications are exported. 
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6. Working with bill of quantities (BOQ) and room lists (RL) 
  

 

(Menu screen when 
measurement is displayed) 

 

(Menu screen when BOQ 
is displayed) 

6.1. Navigating between measurement, BOQ and RL 

To the far left of the group "Project" in the EPIC menu, you will find the buttons "BOQ" (1), "RL" (2) 
(3) and "Measurement" (4) which allow you to navigate between the current measurement, the BOQ 
and the room list. When a measurement is displayed, you can choose to display the associated bill of 
quantities by clicking on "BOQ" (1) or pull up the associated room list by clicking on "RL" (2). When 
the BOQ is displayed, you can choose to display the room list associated with the project by clicking 
on "RL" (3) or jump to the last measurement displayed by selecting the button "Measurement" (4). You 
can also navigate into the BOQ or likewise back into the measurement when the room list is displayed. 

6.2. Editing BOQ and RL 

By selecting "BOQ" (1) or "RL" (2) you access the file of the bill of quantities or the room list 
respectively. You can modify these files. In the BOQ file, you can edit and delete positions or add new 
ones. Enter the required information into the respective columns. In the room list, you can edit and 
delete rooms or add new ones. Once changes are completed, save the BOQ and/or room list file using 
the button "Save" (disk symbol) or the menu items "File" → "Save". When saving, the measurement 
program checks the changes made and sends an error message, if e.g. you have entered already existing 
rooms or ordinal numbers, or the latter are in the wrong format. Changes to the BOQ file and the RL 
are only accepted into the measurement dropdown fields after saving. 
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6.3. Importing BOQ and RL 

In case you did not import the room list and the BOQ upon creating the project, or in case you wish to 
import data in updated form, you can reach for the functions of the group "Project" and use the menu 
item "Import" (5). When importing from an Acad transfer file and importing BOQs of the phases 81, 
83 and 86, you can choose whether the existing BOQ will be overwritten or the positions will be 
appended to the BOQ already imported. When importing a BOQ of the phase 84, prices will be added 
to the BOQ already imported. The room list will always be overwritten on the import. Following the 
import of a room list or a BOQ, the positions and rooms of the measurement in use will be screened to 
check whether they exist in the BOQ and/or RL file. 

6.4. Transferring positions and/or rooms from BOQ and/or RL  

Selecting the button "RL" or "BOQ" will display the respective RL or BOQ files. The group 
"Measurement" will be hidden from the menu and the group "RL" or "BOQ" will be displayed instead.  
Here you will find the function "Transfer rooms" or "Transfer positions" (6), whereby marked rooms or 
positions can be transferred into an open measurement file of the project. To do so, please proceed as 
follows: 

Mark the rooms or positions you wish to transfer by clicking on the respective cells. You can mark 
successive cells by highlighting the cells of the desired rooms or positions while holding down the 
mouse button. Alternatively you can highlight sequential cells by clicking on the beginning of the 
desired cell range and then clicking on the end of the cell range while holding down the Shift key. You 
can highlight incoherent cell ranges by clicking while holding down the CTRL key. 

To transfer marked rooms or positions into the measurement, select "Transfer rooms" or "Transfer 
positions" (6). 
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When transferring positions from the BOQ, the highlighted positions will be transferred into the 
measurement continuously, starting with the last empty position cell. If necessary, new, blank 
measurement sheets will be created. 

 

When transferring rooms from the room list, a window 
appears asking you to select into which measurement 
sheet you wish to transfer the rooms (7). You can also 
choose whether you wish  to duplicate the existing BOQ 
positions in these sheets  or not (8). Otherwise, the rooms  
will continuously be written into the blank room cells of 
the selected sheet.  When the option "duplicate existing 
positions" is activated, you can select several 
measurement sheets by holding down the SHIFT or CTRL 
key (7). The rooms will be transferred into all the 
measurement sheets and, if necessary, the sheets will be 
copied so that for each position in the selected sheets the 
respective room is recorded. 
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7. Creating new measurements 
 

 
 

7.1. Creating a new measurement for the project 

Once a measurement is complete, you can create the next measurement for the project by using the 
button "New Measurement" (1) in the group "Project". Now, a new measurement file will be generated, 
the new measurement number, the building project and the contractor are entered, and the file will be 
saved into the project folder. The numbering of sheets follows the last number of the preceding 
measurement. With that, the preceding measurement is complete. Only the date must be entered into 
the new measurement and now it can be modified as described in section 5. 

7.2. Creating a template for building site measurement 

The function "Building site measurement" in the menu item "Extras" (2) generates a blank 
measurement with positions of the BOQ and, alternatively, also with rooms of the room list. This 
measurement is a regular Excel file and exclusively serves the printing of individual measurement 
sheets to be used on the building site. The building site measurement is not a component of the EPIC 
Measurement Module project and therefore does not provide any functions for entering data.  

When clicking on "Building site measurement" (2), a window appears in which you can select which 
positions and rooms you wish to transfer to the building site measurement. In case you wish to transfer 
only certain rooms or positions, highlight these by holding down the SHIFT or CTRL key (3). The 
program generates a file titled "buildingsitemeasurement.xls" and saves it to the project folder. You can 
enter a measurement number and a date into the first sheet and print out individual measurement sheets 
using the function "File" → "Print". You can use these templates to register quantities on building sites. 
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8. Evaluating measurements (according to quantities, costs and for accounting)  

 
Upon clicking on "Evaluation" (1), a window with a list of measurements belonging to the project will 
open (2). Select the measurements to be evaluated by mouse click while holding down the SHIFT or 
CTRL key. In order to select all measurements, activate the small control box "Mark all" (3). Also, 
select which kinds of evaluation types you wish to use (4). 

 
On the right, you can select different options, like e.g. whether all kinds of evaluation types are to be 
printed into a folder (5), or whether positions and rooms not used are to be listed (6).  
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It is also possible to include only particular rooms or positions into the evaluation (7). When clicking 
on "Select positions to evaluate" or "Select rooms to evaluate" the evaluation window will unfold to the 
right and further options will appear (7): 

 

 
In the windows "Select positions" (9) and "Select rooms" (10) you can select the positions or rooms to 
be evaluated. This procedure is exemplified with the help of the selection of the positions (9); the 
selection of the rooms (10) takes place the same way. 

The positions of the BOQ (14) are displayed in the text window "Select positions" (9) on the left (14). 
Only positions that appear in the text window "Positions selected" (15) on the right will be included in 
the evaluation. In order to transfer positions to the text window to the right (15), highlight the positions 
in the "BOQ" text field by mouse-click and holding down SHIFT or CTRL key (14), and then accept 
them into the text window on the right (15) with a click on the ">" button (16). In order to remove 
positions again, highlight them and click on the "<" button (17).  
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Alternatively, you can also select positions using a search text. To do so, use the entry field to enter a 
search text (12). The following special characters can be used in the search text: 

* indicates at least one optional character 

? indicates exactly one optional character 

# indicates exactly one optional number 

[symbol] indicates one of the symbols listed in square brackets 

Examples: 

Search text 
 

Marked are… 

*.N … all positions containing an "N" in the index, e.g.. 1.1.1.N, 2.30.10.N, 9.10.1110.N,  
except: 1.1.10. 

*.? … all positions with an index, e.g. 1.1.1.N, 2.10.30.A, 3.1.110.X,  
except: 1.1.10. or 2.3.110. 

#.* … all positions containing one-digit ticket numbers, e.g.. 1.20.120., 3.10.25., 9.3.10., 
except: 10.20.120. 

1.1.* … all positions of the group 1.1, e.g.. 1.1.10., 1.1.20., 1.1.110.,  
except: 1.2.10. or 2.1.10. 

[12].1.* … all positions of the group 1.1. and 2.1, e.g. 1.1.10., 2.1.20.,1.3.120.,  
except: 1.2.10. 

 

After entering the search text, click on "Mark hits" (13) and the corresponding positions in the BOQ 
text field (14) will be marked. In order to transfer these to the selection text field (15), click on ">" 
(16). 

In case you wish to select both rooms and positions for the evaluation, you must indicate how both 
search criteria should be linked (11). If you select the linkage "AND", then only the quantities, which 
correspond to either a selected position or a selected room, will be considered for the evaluation.  
When linking with "OR", all quantities, which belong to the selected positions or the selected rooms, 
will be considered. 

Example: Selected rooms are:  110, 111, 112 
Selected positions are :  1.1.1., 1.1.2., 1.1.10. 

Position Room Quantity Selection (11) 
1.1.1. 110 3,0 With „AND“ und „OR“ 
1.1.2. 113 4,0 With „OR “ 
1.1.3. 111 1,2 With „OR “ 
1.1.10. 112 4,5 With „AND“ and „OR “ 
1.1.11. 113 12 Neither with „AND“ nor with „OR“ 
 

After clicking on "Start" (8) the desired evaluations are performed. 
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The following evaluations are possible: 
 
"According to positions" (incl. quantity and cost control): 

 
        (Total price at the end of the table) 

"According to positions" (incl. increase and reduction): 

 
(Total price at the end of the table) 
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"According to positions (accounting)": 

 
(Total price at the end of the table) 

"According to positions (quantity control)": 
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"According to Positions (with single masses)”: 
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"According to cost categories" (cost category control): 

 
 (Sum totals at the end of the table) 

"According to measurements and positions" (incl. quantities and costs): 

 
       (Sum totals at the end of the table) 
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"According to rooms and positions" (incl. quantities and costs): 

 
        (Sum totals at the end of the table) 

"According to rooms and positions (compact)" (incl. quantities and costs): 

 
(Sum totals at the end of the table) 
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"According to positions and sheets" (overview of the used positions and quantities): 

 
         (Sum totals at the end of the table) 

"According to positions, rooms and sheets": 

 
(Sum totals at the end of each row)  
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"According to the use of the positions" (position proof for overview): 

 



 
 
 

 
Engineering Office 
Elektroplanung GmbH 

 
 
 

 
 35 

 

 

EPIC

Trade Register Jena, HRB 103884 
Managing Director:  
Dipl.-Ing. W. Sturm 

9. Changing project and program settings 

9.1. Project settings 

In the group "Project" in the EPIC menu, you will find the button "Settings". Here, the project details 
are displayed in the tab "General" (1). Here, you can make changes to the building project and 
contractor (2) as well as the starting sheet number (3). The changes will be transferred to all 
measurement files of the project. 

 

 
 

The OZ format, which you have either selected when creating the project or which you imported with 
the BOQ, can also be changed by selecting "Change format" (4). For details on how to import the OZ, 
please refer to section 4.1. 
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The "Settings" window under "Files" (5) displays the location of the saved project (6), the 
measurement files assigned to the project (7) as well as the BOQ and RL files (8). If necessary, you can 
integrate other BOQ and RL files into the project by clicking on "Change" (9). Here, you can also 
rename a measurement file by marking and right-clicking it, add measurement files before or after 
existing measurements, or even delete measurements from the project (10). 

To delete a measurement file, first delete the file in the "Project Settings" window by selecting the 
function "Delete from project" (10). The measurement will then be removed from the project and the 
measurement numbers and sheet numbers of the following measurements will be updated.  However, 
the file names of the measurements remain unchanged. The measurement file removed from the project 
remains in the file system and can be deleted via Window Explorer when it is no longer needed 

Important: Never delete a measurement file in Windows Explorer without prior removal from the 
project! Only perform the renaming in the "Project Settings" and never in any other programs, like 
e.g. Windows Explorer. If measurement files, BOQ files or room list files of a project are changed 
outside of the "Project Settings", they can no longer be linked to the project! 
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9.2. Program settings 

 

 
 

By clicking on "Settings" (11) in the group "EPIC Measurement Module 2.0" of the EPIC menu, a 
window will open which allows you to select different settings for the measurement program. These 
settings will then be applied to all projects. 

 

 
 

Here, you can also select whether Excel formulas entered into the quantity range of the measurement 
should appear in the print out, or whether only the result of the formula should be displayed (12). In 
addition, you can indicate how many decimal places for quantities and prices you wish to see displayed 
in the measurements and evaluations (13). Furthermore, prices can alternatively be displayed in euro 
format. The standard folder in which new projects are created can be changed (14) and you can specify 
whether you wish the program to search for updates automatically on a weekly basis (15). You may 
want to activate this option in order to stay informed about updates. Thereby no personal information 
will be transferred to the EPIC server. 
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9.3. Info 

 
The button "Info" (16) provides you with information on the latest installed version of the 
measurement program and offers you the option of checking for available updates (17). 

In case the measurement program is not yet activated, you will be informed on how long the program 
will remain in test mode. After activating with a license key, your license data will appear again in this 
place. 
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10. General information 

10.1. Notes on the use of the measurement module 

• Do not waive the sheet protection of the measurement sheets 
• Please do not add new rows or columns (if needed, create a new sheet instead) 
• Please do not change the sheet titles or their sequence 
• Only write into designated white areas 
• You may modify or adjust column width and the row height   
• Do not delete or modify the project file *.amxml, and do not rename the files in Windows 

Explorer. Instead, please use the functions for files in the "Project Settings". 

10.2. Troubleshooting 

Should you determine any errors or problems when using the EPIC Measurement Module, please send 
an email to epic-support@online.de providing the following information: 

• Windows version used 
• Excel version used 
• EPIC Measurement Module version used (see here: "EPIC" →"Info") 
• Detailed description of the problem including, if possible, the exact wording of the error 

message displayed 
• If possible, please attach the project file in which the error occurred as a zip file 

We will do our best to locate and eliminate the error as fast as possible and get back you.  

We also welcome your feedback for improvements. 

 

mailto:epic-support@online.de
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11. Appendix: Structure of the EPIC menu in Excel 2003 

11.1. Group "EPIC Measurement Module 2.0" (Excel 2007 and higher) and/or "EPIC" (Excel 2003) 

 

In Excel 2003, the group "EPIC Measurement Module 2.0" is labelled "EPIC" due to lack of space. 
The button "Activate" will disappear once you have successfully entered the license key. 

• Appearance in Excel 2007 or higher: 

 
 

• Appearance in Excel 2003: 

 



 
 
 

 
Engineering Office 
Elektroplanung GmbH 

 
 
 

 
 41 

 

 

EPIC

Trade Register Jena, HRB 103884 
Managing Director:  
Dipl.-Ing. W. Sturm 

11.2. Group "Measurement" 

• Appearance in Excel 2007 or higher: 

 
 

• Appearance in Excel 2003: 

 
In Excel 2003, you will find the dropdown fields for positions (1) and rooms (2) in the toolbar (3). 

 
 

1 

2 

3 

1 5 6 7 2 4 



 
 
 

 
Engineering Office 
Elektroplanung GmbH 

 
 
 

 
 42 

 

 

EPIC

Trade Register Jena, HRB 103884 
Managing Director:  
Dipl.-Ing. W. Sturm 

Aside from dropdown fields for positions and rooms, the Excel 2003 toolbar also contains buttons 
for the most frequently used functions of the group "Measurement". These are: "Create new sheet" 
(4), "Delete current sheet" (5), "Print measurement" (6) and "Subtotal" (7).  

11.3. Group "Project" 

• Appearance in Excel 2007 or higher: 

 
 

• Appearance in Excel 2003: 

 
 

Additionally, the toolbar contains buttons for the navigation to the bill of quantities (BOQ) (8) and the 
room list (RL) (9) as well as for the creation of the next measurement (10). 
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